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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2006 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California.

Windows® is a U.S. registered trademark of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

All other product names are the property of their respective trademark or service mark holders and are 
hereby acknowledged.
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Documentation Updates

To verify that the manual you are using is in fact the most recent edition, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

Locate the product, then look to see if a more recent edition of this document is available for downloading. If 
you subscribe to the appropriate product support service, you can arrange to have document updates sent to 
you. Contact your HP sales representative for details.
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Support

Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support 

This site provides contact information and details about the products, services, and support that HP 
OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valued 
support customer, you can benefit by using the support site to:

• Search for documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many also require a 
support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

http://www.managementsoftware.hp.com/passport-registration.html
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1 Overview
This chapter covers the following topics:

• HP Performance Insight

• Reporting for OpenView Operations (OVO)

• Data Collection

• Folders and Reports

• OVO and Message Generation

• Sources for Additional Information

HP Performance Insight

Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Location Independent Reporting (LIR)

• Archiving via Long Term Retention (LTR)

• Multiple aggregation options (by hour, day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks via top-10 ranking

• Easy identification of capacity trends

• Accurate and timely documentation for management

• Integration with Network Node Manager (NNM)

• Integration with OpenView Operations (OVO)
7



The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. See the following table for details.

Business Technology Reporting Solution

Application Server • Application Server Report Pack
— WebLogic SPI
— WebSphere SPI

Database SPI • Database Report Pack

HP Internet Services • Internet Services Report Pack

HP Network Node Manager • NNM Event & Availability Report Pack

HP Service Desk • Service Desk Report Pack
• SLM Integration Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN • MPLS VPN Report Pack

Networking Traffic Profiling

• RMON II

• NetFlow Interface

• NetFlow Global View

• IP QoS Report Pack

• Class-Based QoS Report Pack

Quality Assurance

• Cisco Ping 
• Service Assurance
• IP Access Rate

Infrastructure Usage

• Interface Reporting
• Device Resource

LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)

System Resources • System Resource Report Pack
8 Chapter 1



Reporting for OpenView Operations (OVO)

Version 1.0 of the OVO Report Pack was released May, 2006. Version 1.1 includes support for 
LIR configuration. The steps you take to enable LIR are covered in Chapter 4, Setting Up a 
Distributed System. In addition to LIR, version 1.1 includes the defect fixes listed below.

The OVO Report Pack processes the following data from one or multiple OVOu servers:

• Message patterns based on OVOu Active message tables

• Message patterns based on OVOu History message tables

• Service status based on the OVOu Service Log table

The OVO Report Pack maintains the follow data sets:

• Active Messages (currently unacknowledged)

• Active + History Messages (consolidated message reporting)

• Service Log

• Configuration

Each data set has four summary tables and four reporting views. (There is extensive use of 
object_byvar=yes in the property tables.) The scope of reporting is as follows:

• Multiple groups and many roll-up combinations for:

— All OVO servers

— Node and Application

— Node and Template

— Server and Service

• Server configuration reporting

• Template and Condition reporting

Data Collection

The data collection function works as follows:

• Modeled after the OVIS datapipe

• Written in JAVA

• References systems.xml

• Logs to trend.log

Defect Issue

QXCR1000401476 Mapping between managed_nodes and Customers & Locations.

QXCR1000371765 OVO RP update_OVO_MSG_props.sql hanging on Oracle.

QXCM1000353122 OVOu datapipe not collecting data.

QXCR1000381445 Multiple issues with OVOu datapipe.

QXCR1000384269 OVO datapipe problem when multiple cma pairs.
Overview 9



• Exports data to TSV (tab separated)

• Imports data using ee_collect

• Active snapshots are exported using views

Sybase Limitation

Due to a Sybase limitation in the length of the index, a serial number (identifier) is generated 
on three large text fields

• Service

• Application

• Condition description

Data Export

Data is exported in four distinct data sets

• Active Messages – Exports active message counts based on the following three groupings

— Server Node - Application

— Server Node - Message Group

— Server Node - Service

• Consolidated Messages – Exports all new active and history messages since last collection

• Service Logs – Exports all service log entries since last collection

• Configuration – Once a day, the configuration for all trouble ticket and notification 
channels is exported

Why Consolidated Messages?

Consider this simple scenario (two report problem)

1 Fort Knox monitoring receives 200 events on January 10th

2 The operators only acknowledge 175 events leaving 25 events for the next day

3 At 6:45AM on January 11th, Andrew H. Card has one simple question. How many events 
came into the Fort Knox NOCC? 

The answer is in two reports: one report for the 25 remaining active messages and another 
report for the 175 acknowledged messages. Combined reporting solves the two-report 
problem, and this is how it works:

• Single report table in OVPI allows the reporting on all messages for the previous day

• An OVPI reaper process handles the active-to-history transition

Export Views

Export views are created with the following abbreviations

• A – Application

• M – Message Group

• N – Node

• O – Server
10 Chapter 1



• S – Service

• U – User

• T – Template/Policy

• D – Condition Description

Examples:

• RV_OVO_MSG_BASE_A – View of R_OVO_MSG_BASE for rollups by Application

• RV_OVO_MSG_BASE_ON – View of R_OVO_MSG_BASE for rollups by Server and Node

• RV_OVO_MSG_BASE_OTD – View of R_OVO_MSG_BASE for rollups by Server, 
Template, and Condition

Folders and Reports

Installing the OVOu Report Pack deploys the following report folders and reports:

Folder Contents

Active (14) • Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node and Service Trend
• Message Severity by Server
• Message Severity by Server and Application
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Service Trend
• OVO Server Summary

Message Weekly (3) • Weekly History Dashboard by Template
• Weekly History Dashboard by Template and Condition
• Last Week Dashboard by Server and Template

Config (2) • Notif Channels
• Trouble Ticket Channels

Message (27) • History Dashboard by Server and Node
• History Dashboard by Server Node and Template
• Message Age Severity by Server and User Trend
• Message OVO Server Summary
• Message Severity by All Messages Trend
Overview 11



OVO and Message Generation

Knowing how OVO generates messages is good background information. Here is the 
high-level sequence of events:

1 An event occurs on a managed object. The managed object creates a message.

2 The OVO agent on the managed node receives the message.

3 The message is compared to filters. Messages matching suppress conditions or duplicate 
messages are suppressed. Other messages are forwarded.

4 The message is logged locally.

5 Messages that match filters are converted to the OVO message format, and forwarded to 
the management server.

6 The management server processes the message by taking one of these actions:

• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node Trend
• Message Severity by Node and Application Trend
• Message Severity by Node and Message Group Trend
• Message Severity by Node and Template Trend
• Message Severity by Node and Service Trend
• Message Severity by Server Trend
• Message Severity by Server and Application Trend
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server and Template Trend

Message (con’t) • Message Severity by Server and User Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Server, Template and Condition Trend
• Message Severity by Service Trend
• Message Severity by Template Trend
• Message Severity by Template and Condition Trend
• Message Severity by User Trend
• Monthly Server Breakdown with Special Flags
• Server Breakdown with Special Flags
• Template Breakdown with Special Flags

Service Log • Severity Trend (Daily messages by services; by severity and 
duration details daily, weekly, and monthly)

Folder Contents
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• Assigns the message to another message group (regrouping).

• Starts non-local actions configured for the message on the specified node.

• Forwards the message to external notification interfaces and trouble ticket service.

• Escalates the message to another preconfigured management server.

• Buffers the message in the Pending Message Browser.

7 The active message is stored in the database.

8 The message displays in a Message Browser window.

9 When the message is acknowledged, it is removed from the active browser and put into 
the history database.

What are Active Messages?

• They are messages that have not been acknowledged by an OVO operator.

• They display in the OVO Message Browser.

• They reside in the opc_act_messages table.

What are History Messages?

• They are messages that have been acknowledged.

• History messages are moved to the opc_hist_messages table for historical analysis.

What is a Message Group?

A message group is a convenient way to categorize messages. Messages belonging to the same 
function or task can be collected into a single group. For example, the message group Backup 
can contain all messages that relate to the backing up and storing of data (for example, 
messages originating from a network backup program, pieces of hardware used in the backup 
or storage operation, and so on). Message groups are then assigned to operators, who see and 
manage only those groups assigned to them. 

What is an Application?

An application can be a program, command, script, utility or service that the operator uses to 
maintain and control system and network services. For example, a backup program, and the 
process status command ps, can be integrated as applications.

Sources for Additional Information

The demo package that comes with the OVO Report Pack contains a sample of each report in 
the package. If you have access to the demo package and you want to know what 
fully-populated reports look like, install the demo package. Like real reports, demo reports are 
interactive. Unlike real reports, the data in a demo report is static.
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For details about known issues and recent enhancements, see OVO Report Pack 1.1 Release 
Notes. 

The manuals for OVPI core, and the manuals for the reporting solutions that run on OVPI 
can be downloaded from this site:

http://ovweb.external.hp.com/lpe/doc_serv/

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Each manual indicates 
a date. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, be sure to compare your PDF to the PDF on the web and use the 
web version if it is newer.
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2 Installation and Configuration
This chapter covers the following topics: 

• Guidelines for a Smooth Installation

• Using Package Manager to Install OVO Reporting

• Setting Up a Connection to the OVOu Database

• Configuring OVOu for Active Message Export

Guidelines for a Smooth Installation

An OVPI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install the datapipe, you configure OVPI to 
collect a specific type of performance data at a specific interval. When you install the report 
pack, you configure OVPI to summarize and aggregate the data collected by the datapipe.

The report pack CD contains report packs, datapipes, shared packages, and documentation. If 
you, or someone else, extracted packages from the CD, then every package, including the OVO 
Report Pack and the OVO Datapipe, was copied to the Packages directory on your system and 
is now ready to install. Your next step is to launch Package Manager and follow the on-screen 
instructions. 

If you have not extracted packages from the report pack CD, do that now. You will find a CD/
package extract procedure later in this chapter. Extracting packages to the Packages directory 
launches Package Manager. Before using Package Manager to install OVO Reporting, be 
familiar with the prerequisites for OVO Reporting.

Supported Environments

The OVO Report Pack is designed to operate in the following environments:

The environment described above provides the Oracle connectivity required to connect to the 
OVOu Oracle database and extract the necessary data sets. The following must be enabled to 
connect to the OVOu Oracle database:

OVPI Version Oracle Sybase

5.0 + SP3 9.0.2.4 11.9.2.5

5.1 + SP1 9.0.2.5 11.9.2.5

5.2 10g 15
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• The OVOu server hostname must resolve to an IP address (ping the hostname).

• The OVOu Oracle database connection information must be added to OVPI via the OVPI 
Management Console Systems Information application.

After you install OVO Reporting, you will set up a connection with the OVOu database. Be 
prepared to provide the following information:

• OVOu database server name (resolvable hostname)

• Port number that the OVOu database is accepting connections

• Oracle SID for the OVOu database

• OVOu database user name

• OVOu database password

You must be authorized to create and drop database views. To create views manually, execute 
the scripts located in the following directory:

Packages/OVO_Reporting/OVO_Datapipe.ap/Oracle

Upgrading Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade to version 
3.6. If you are not running any version of Common Property Tables, Package Manager will 
install the latest version of Common Property Tables for you, automatically.

When you upgrade Common Property Tables, do not install the upgrade package and other 
packages at the same time. Instead, install the upgrade package for Common Property Tables 
and nothing else. Once Common Property Tables is upgraded, you are free to re-start Package 
Manager and install more packages. For more information about Common Property Tables, 
refer to the Common Property Tables 3.6 User Guide.

Using Package Manager to Install OVO Reporting

This section covers the following tasks:

• Task 1: Extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Start Package Manager and install these packages:

— OVO Reporting 1.1

— OVO Datapipe 1.1

Task 1: Extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

If an earlier version of OVO Reporting is already installed, uninstall that version before 
installing the new version.
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HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the April 2007 report pack CD in the CD-ROM drive. On Windows, a Main Menu 
displays automatically; on UNIX, mount the CD, navigate to the top-level directory for the 
CD drive, and type the setup command. 

4 Select OVPI report packs by typing 1 in the choice field and pressing Enter. The install 
script displays a percentage complete bar. When the extraction finishes, the install script 
starts Package Manager. The Package Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following directory 
structure:

{DPIPE_HOME}/Packages/OVO_Reporting/OVO.ap

{DPIPE_HOME}/Packages/OVO_Reporting/OVO_Demo.ap

{DPIPE_HOME}/Packages/OVO_Reporting/OVO_Datapipe.ap

Installing the demo package is optional. You may install the demo package by itself, or you 
may install the demo package along with the report pack and the datapipe. 

Task 2: If necessary, upgrade to Common Property Tables 3.6

When performing this upgrade, observe these rules:

• Do not install anything else; install the upgrade package and only the upgrade package. 

• When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not get the forms.

• When the install finishes, click Done to return to the Management Console.

Task 3: Install the OVO report pack and the OVO datapipe

1 If Package Manager is not running, select Tools > Package Manager from the Management 
Console. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the default for application server name and port. Type your username and 
password for the OVPI Application Server. 
Installation and Configuration 17



5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

• OVO_Reporting 1.1 

• OVO_Datapipe 1.1

7 Click Next. The Type Discovery window opens. 

8 Disable the default to run Type Discovery immediately after package installation. 

9 Click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install finishes, a package install complete message appears. 

11 Click Done to return to the Management Console. 

12 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

OVO Reporting does not require Type Discovery. If you are installing other report 
packs in addition to OVO Reporting, you may need to run Type Discovery for those 
packages. 
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Setting Up a Connection to the OVOu Database

The OVPI server cannot connect to the OVOu database unless it has the information it needs 
to make the connection. You supply this information by selecting the System option from the 
Management Console and launching the Add Database Wizard.

The OVO Datapipe uses the following files to determine which OVOu databases it will collect 
data from and how to connect to each database:

The ovou7servers.prp and the ovou8servers.prp are part of the OVO Report Pack; they were 
put in place when you installed the report pack.

If the ovou_datapipe process is initiated, and if the -dataset option is the only option specified, 
ovou_datapipe will collect data from every OVOu server listed in both of the .prp files. After 
identifying which OVOu servers to collect from, the ovou_datapipe process looks up 
connectivity information for each OVOu server in the systems.xml file.

The ovou_datapipe process cannot operate correctly unless the following requirements are 
met: 

• The OVOU database server hostname is pingable from the OVPI server.

• The following details are available:

— OVOu database server name (resolvable hostname)

— Port number that the OVOu database is accepting connections

— Oracle SID for the OVOu database

— OVOu database user name

— OVOu database user password

Adding an External Database to OVPI

Follow these steps to connect OVPI to the OVOu database:

1 Start the Management Console and login as the OVPI administrator.

File Function

{DPIPE_HOME}/data/ovou8servers.prp List of OVOu8 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVOu7 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database
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2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 In the center pane under the System Information folder, open the container representing 
the local OVPI server.
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4 Right-click Databases and select Add OVPI Database. The Add Database Wizard opens. 

5 Click Next. The Type of Database window opens. 

6 Select Generic Supported Database and click Next.
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7 In the Database Connectivity Information window, add information about the OVOu 
database. 

Hostname: IP Hostname of the OVOu server

Port: The port the database is listening on

Description: User-specified description

Vendor: Oracle

Database Instance: SID of OVOu database

Database Username: OVOu database login

Password: OVOu database password for login
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8 Click Next. The Identify System window opens. 

9 Type a name and a description. 

You may use the hostname as the name. Use any name that is meaningful to you.

The name you specify here will appear in two places, in the <Name> field in the 
systems.xml file, and in reports. The OVOu Datapipe will use the name you specify here to 
locate connectivity information for the OVOu database.

Later you will register an OVOu server with the OVOu Datapipe. This is a simple matter 
of adding a server name to a file. The name you add to the file must be an exact match 
with the name you entered here, in the Identify System window.
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10 Click Next. The Summary Page window opens.

11 Review the contents of the Summary Page. If everything is okay, click Finish.
24 Chapter 2



12 Verify that the connection you just added is recognized by OVPI by selecting the new 
database in the in the System/Network Administration pane. Review the connectivity 
parameters.

13 Click the Test Connection button to verify that OVPI can connect to the OVOu database.

Registering OVOu Servers with the OVOu Datapipe

After you add connections from OVPI to each external database, you must add each system to 
the appropriate .prp file. Using an editor, open the following plain text files:
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{DPIPE_HOME}/data/ovou7servers.prp

{DPIPE_HOME}/data/ovou8servers.prp

Add to the file one line for each OVOu server you want to collect from. If you are collecting 
from multiple servers, list each server on a separate line. If you are collecting from a single 
OVOu server, the file will contain one line. No other information is allowed in this file. Do not 
insert comments or any other information.

Each name you add to this file must match the name you typed in the Identify System 
window. The OVOu Datapipe will use these names to locate connectivity information in the 
systems.xml file. These names will also appear in reports. 

Configuring OVOu for Active Message Export

The OVOu Datapipe does not export messages from the Active Message table. Instead, it 
takes a snapshot of current Active Message statistics, and then summarizes the results to 
hourly, daily, weekly, and monthly levels. The results are similar to HISTORY statistics. The 
difference is that taking a snapshot of current statistics produces a summary of “Current 
Active Messages” as compared to “New HISTORY”.

To make the snapshot of current Active Message statistics possible, you must create three 
separate export views on the OVOu database. The OVO Report Pack rollup generates 
additional levels of data from the data provided by the export views.

The following export views are created for the element level indicated:

OVPI_ACT_ONA:OVO_SERVER – NODE_NAME – APPLICATION

OVPI_ACT_ONS:OVO_SERVER – NODE_NAME – SERVICE_NAME 

OVPI_ACT_ONM:OVO_SERVER – NODE_NAME – MSG_GROUP

Until you create these views, current Active Message statistics will not be exported from that 
OVOu server. Follow these steps to create views:

1 Login to the OVPI server as the OVPI administrator (trendadm on Unix).

2 Execute the following command at the command line:

ovou_datapipe -dataset create_view –database <nsprod1> –server u8

For each OVOu database listed in the ovou[7|8]servers.prp file, four blocks of messages will 
be printed on the command line. The messages indicate that SQL statements are being 
executed to create four table views in each OVOu database.

How the Export Program Operates

The OVOu export program connects to the OVOu database and exports information from 
Consolidated and Service Log tables. When the export process runs for the second time, only 
new records will be exported from the tables.

The export process is driven by an OVPI trend_proc batch file. After installation, the file will 
be located in the following location:

{DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

If the views fail to create, verify that you have permission to create and drop views.
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This file drives three separate export processes, one for each of the three required OVOu 
datasets. Here is the executable command for each dataset:

ovou_datapipe -dataset MSG

ovou_datapipe -dataset SRV_LOG

ovou_datapipe -dataset ACT

The name of the export program is ovou_datapipe. Although the program has several 
configurable parameters (see below), in most cases only the -dataset parameter is needed. 
The following files contain the information that the ovou_datapipe export program requires to 
connect to each OVOu database:

If the -dataset option is the only option specified when the ovou_datapipe process is 
initiated, ovou_datapipe will collect data from every OVOu server listed in the 
ovou[7|8]servers.prp file. The ovou_datapipe process will use the list of servers in the 
ovou[7|8]servers.prp file to locate connectivity information in the systems.xml file.

Export Program Parameters

The OVOu export process is flexible. The following table describes each parameter.

File Function

{DPIPE_HOME}/data/ovou8servers.prp List of OVOu8 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVOu7 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database

Parameter Description

-dataset <ACT|MSG|CFG|SRV_LOG|create_view|drop_view>
ACT: export OVOu Active Message Statistics.
HIST: export OVO Consolidated Messages.
CFG: export OVOu channel configuration.
SRV_LOG: export OVOu Service Log records.
create_view: create OVOu Active Message Statistics database views.
drop_view: remove OVOu Active Message Statistics database views.

-database “Name” of OVOu server to connect to and export OVOu data from. 
The specified name must match an entry in OVPI’s systems.xml file 
based on the “<Name>” tag field in the systems.xml file. This must 
also match an entry in the ovou[7|8]servers.prp file.
Normally, no OVOu server will be specified and data will be collected 
from all OVOu servers listed in the ovou[7|8]servers.prp file.

-datadir By default, data is exported to $DPIPE_HOME/data/ImportData/
OVO_Reporting. A different location can be specified using this 
option.
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The first time the export process runs, an excessive amount of data can be exported from the 
OVOu database if the process is allowed to go back too far to locate records to export. If 
desired, you can limit the amount of data that will be exported by configuring the OVOu 
datapipe to go back a specific number of days. If you do not specify a value for this parameter, 
the export will adhere to the default, which is to export messages no older than midnight of 
the previous day.

The “-prevdays” option does not apply to all datasets. For example, the OVOu Active Message 
table export process does not actually export message records. Instead, a small number of 
records are captured that provide a snapshot of “current” record statistics for the OVOu 
Active Message table. In this case there is no need to specify a maximum number of days to 
include in the export process.

Testing the Export Process

Run the following command to test the export process:

ovou_datapipe –database XYZ –server u7 –dataset ACT

To view the results, navigate to the following directory:

data/ImportData/OVO_Reporting

-prevdays Specifies the number of days prior to today to collect data inclusive 
of today. Only used if the previous collection time is not stored in the 
maxtime.<TIME_TABLE>_<TIME_FIELD> file or for the first 
execution. The default value is 1 day. This parameter only applies to 
History and Service log data.

-debug Set for Debug output.

-help Display help information.

-version Display ovou_datapipe version.

-V Display ovou_datapipe version.

-server Either u8 or u7 corresponding to the database specified in -database

Parameter Description

OVOu export files are imported into OVPI and then deleted by default. If archiving is 
enabled, you can avoid filling up the filesystem by setting up a process to clean out the export 
files. Clean the export files from the following location on the OVPI server:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive
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3 Verification Steps
This chapter will help you confirm that OVO Reporting is properly installed and working 
correctly. It provides a way to answer each of the following questions: 

• Does trendtimer.sched contain collection and rollup entries?

• Did the reports deploy as expected during package installation?

• Is the data export program working?

• Is OVPI importing data?

• Are the hourly tables being populated?

• Are the daily tables being populated?

• How can I remove the OVO report pack?

These steps will help you verify that the OVO Report Pack is operating correctly. These steps 
are not required. You may skip them unless you have reason to believe that something is not 
working the way it should.

Collection and Rollup Entries in trendtimer.sched

The installation process adds entries to trendtimer.sched to ensure that processes are 
executed as needed by trendtimer. The following entries are added to trendtimer.sched:

# HP OVO Reporting Project

1:00+5 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

24:00+2:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Daily.pro

### OVO Reporting Daily Processing

24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/Daily_OVO_Rollup.pro

Correct Deployment of Reports

If the deploy reports options was selected during the installation process, the reports were 
deployed to the OVPI server you specified. To verify that the reports deployed as expected, 
check this directory:

{DPIPE_HOME}/reports/deploy/system/OVO_Reporting
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The Data Export Program is Working

Data collection will take place for the first time at 5 minutes past the hour (1:00+5 - -), in 
accordance with entries added to trendtimer.sched for data collection when OVO Reporting 
was installed. This process exports records from the OVOu database into flat files on the 
OVPI server. The OVOu data is later imported into the OVPI database and summarized by 
the daily rollup process specific to each dataset.

The following command can be executed at the command line to initiate the ovou_datapipe 
export process manually:

trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

After the successful completion of the above command, the exported data should be located in 
the following directory:

{DPIPE_HOME}/data/ImportData/OVO_Reporting

The exported OVOu data in that directory should be in files with names similar to the 
following:

OVO_ACT_ONA_<ovou server name>_<date>_<time>.dat

OVO_ACT_ONM_<ovou server name>_<date>_<time>.dat

OVO_ACT_ONS_<ovou server name>_<date>_<time>.dat

OVO_MSG_HIST_<ovou server name>_<date>_<time>.dat

OVO_MSG_ACT<ovou server name>_<date>_<time>.dat

OVO_SRV_LOG_<ovou server name>_<date>_<time>.dat

OVO_CFG_LOG_<ovou server name>_<date>_<time>.dat

OVPI Is Importing Data

The OVOu data is imported into the OVPI database by the daily rollup process specific to each 
dataset. Each daily rollup process imports the appropriate dataset files and then steps 
through the rollup of that dataset.

The import process will populate the following data tables in the OVPI database with records.

The first time the ovou_datapipe program runs, by default, the program exports data records 
received since midnight of the previous day. If desired, you may override the default. To force 
the export process to include records from further back in time, use the -prevday option and 
specify the number of days. This parameter only affects the first time the export program is 
executed for a specific dataset. After that, the export program keeps track of the last exported 
timestamps and only exports the records that arrived since the previous export.

If this option is desired, add the -prevday option to the ovou_datapipe statements before 
executing the datapipe the first time. If there are any timestamp files in {DPIPE_HOME}/
Data/ImportData/OVO_Reporting, these timestamp files will override the -prevday option. 
They must be deleted for the -prevday option to work.

The data is imported into OVPI once per day as part of the daily rollup process.
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• R_OVO_MSG_BASE

• R_OVO_ACT_BASE

• R_OVO_SRVLOG_BASE

• R_OVO_CONFIG_BASE

Verify this in Table Manager by navigating to the OVO_Reporting Category and locating the 
tables listed above.

The oldest and most recent time stamps can be determined for the import tables by executing 
the following SQL statement in SQLplus, ISQL, or SQL Advantage:

select ‘R_OVO_MSG_BASE’, min(ta_period), max(ta_period) from R_OVO_MSG_BASE

select ‘R_OVO_ACT_BASE’, min(ta_period), max(ta_period) from R_OVO_ACT_BASE

select ‘R_OVO_SRVLOG_BASE’, min(ta_period), max(ta_period) from R_OVO_SRVLOG_BASE

select ‘R_OVO_CONFIG_BASE’, min(ta_period), max(ta_period) from R_OVO_CONFIG_BASE

This should return valid date/times in the second and third column if data has been imported.

The OVOu export files should have been archived to the following location by the OVPI data 
import process:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive

If the OVOU export files are in the “OVO_Reporting” directory but not in the “Archive” 
directory, the OVOU export ran successfully but the import process was not successful. You 
will find errors relating to the import process in this file:

{DPIPE_HOME}/log/trend.log

The Hourly Data Tables Are Populated

After several hours of data have been imported into the OVO Report Pack’s Base tables within 
the OVPI database, the hourly rollup process can be initiated as follows:

1 Change directory to {DPIPE_HOME}/scripts

2 Execute the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the hourly data tables have been populated, or execute 
the following SQL statements:

select ‘SH_OVO_MSG’, min(ta_period), max(ta_period) from SH_OVO_MSG

select ‘SH_OVO_ACT’, min(ta_period), max(ta_period) from SH_OVO_ACT

Records will only be added to these tables if the OVOu server has received new records for 
those datasets.
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If data was rolled up to the hourly level, these statements should return valid date/times 
in the second and third column.

The Daily Tables Are Populated

After a complete day of data has been imported into the OVO Report Pack’s Base tables within 
the OVPI database, the daily rollup process can be initiated again using the same command 
as specified above:

1 Change directory to {DPIPE_HOME}/scripts

2 Execute the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the daily data tables were populated, or execute the 
following SQL statements:

a select ‘SD_OVO_MSG’, min(ta_period), max(ta_period) from SD_OVO_MSG

b select ‘SD_OVO_ACT’, min(ta_period), max(ta_period) from SD_OVO_ACT

c select ‘SD_OVO_SRVLOG’, min(ta_period), max(ta_period) from SD_OVO_SRVLOG

If data rolled up to the daily level, these statements should return valid date/times in the 
second and third column.

The daily rollup processes also force the summarization to the weekly, monthly, and baseline 
level, if enough time has passed and enough data has been collected to summarize to those 
levels. Data can only rollup to the next time interval when the time period is complete. For 
example, monthly data for the month we are in now will not be generated until the present 
month has ended.

Verify those tables using the following SQL statements:

select ‘SW_OVO_MSG’, min(ta_period), max(ta_period) from SW_OVO_MSG

select ‘SM_OVO_MSG’, min(ta_period), max(ta_period) from SM_OVO_MSG

select ‘SW_OVO_ACT’, min(ta_period), max(ta_period) from SW_OVO_ACT

select ‘SM_OVO_ACT’, min(ta_period), max(ta_period) from SM_OVO_ACT

select ‘SW_OVO_SRVLOG’, min(ta_period), max(ta_period) from SW_OVO_SRVLOG

select ‘SM_OVO_SRVLOG’, min(ta_period), max(ta_period) from SM_OVO_SRVLOG

The individual steps of any trend_proc file can be executed at the command line as 
long as the environment variables are defined correctly and slashes are in the 
correct direction (/).
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Uninstalling the OVO Report Pack

Follow these steps to uninstall the OVO Report Pack.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If Application Server reports were deployed from this server, accept the defaults for 
Undeploy Reports, Application Server Name, and Port. If Application Server reports were 
not deployed from this server, clear the check box and skip to step 9.

8 Type the username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens. 

10 Click the check boxes next to the following packages, if they appear in the list:

• OVO Reporting 1.10

• OVO Datapipe 1.10

11 Click Next. The Selection Summary window opens. 

12 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

13 Click Done to return to the Management Console.

14 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
If you intend to run the OVO Report Pack as a distributed system, you must verify that you 
have the right packages installed on each server and configure all of the servers in the system. 
This chapter covers the following topics:

• Verifying Correct Package Installation

• Configuring the Central Server

• Configuring Satellite Servers

• System Clocks

Verifying Correct Package Installation

Verify that you have the right packages installed on each server. 

Packages on the Central Server

• OVO Report Pack, with reports deployed

• Common Property Tables, with forms deployed

Packages on Each Satellite Server

• OVO Report Pack 

• Common Property Tables 

• OVO Datapipe

Typically, the central server does not poll. If you want the central server in your system to 
poll, install a datapipe on the central server. If you want to view reports on satellite servers 
(local reporting) accept the Deploy Reports option when you install report packs at each 
satellite server. If central server reporting is the only reporting you want, you do not need to 
deploy reports and forms when you install report packs at satellite servers. 

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: Enable LIR (location independent reporting)

• Task 3: Add LIR mappings

• Task 4: Verify the automatically generated copy policies
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• Task 5: Edit trendtimer.sched and multiple process files

For more information about LIR and copy policies, refer to the HP Performance Insight 
Administration Guide.

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

Follow these steps to configure LIR mappings: 

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select OVO from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 Click OK.

12 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied (defined 
in the generated copy policy) is one summarization level greater than the data type selected in 
the LIR mapping. For example, if you select an hourly data type, you will generate a daily 
data copy policy.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 The following tables should appear in the copy policy list:

• SH_OVO_ACT

• R_OVO_ACT_BASE 

• SH_OVO_MSG 

• R_OVO_MSG_LOOKUP_D

• R_OVO_MSG_LOOKUP_S

• R_OVO_MSG_LOOKUP_A

• R_OVO_MSG_BASE

• SD_OVO_MSG 

• SD_OVO_SRVLOG

• R_OVO_CONFIG_BASE

For each table, verify that copy type is set to Property and Data.

4 If a copy policy has not been generated for any of the tables listed above, click the New 
Copy Policy icon or select File > New Copy Policy from the Copy Policy Manager. The Copy 
Policy Wizard opens.

5 Click Next. The Satellite Server and Copy Policy Selection Page opens.

6 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

7 Select Single Table and select the table from the pull down list.

8 Click Next. The Copy Type Selection Page opens.

9 Select Property and Data.

10 Click Next. The Summary page opens.

11 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

12 Click Finish.

13 Repeat step 4 - step 12 for all missing tables.

If only the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.
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Task 5: Edit trendtimer.sched and multiple process files.

1 Change the trendtimer.sched file located in {DPIPE_HOME}/lib for the central server 
from this:

## 24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro

to this:

## 24:00+9:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro 

2 Edit the Daily_OVO_MSG_Rollup.pro file:

• Comment out block 1, 

3 Edit the Daily_OVO_ACT_Rollup.pro file:

• Comment block 1,

4 Edit the Daily_OVO_SRVLOG_Rollup.pro file:

• Comment out block 1,

5 Edit the Daily_OVO_CONFIG_Rollup.pro file:

• Comment out block2,

Configuring Satellite Servers

Configure each satellite server by enabling copy commands that are disabled by default. Once 
the copy commands are enabled, the central server will handle the summarizations. The copy 
commands appear in hourly process files in the Scripts directory. Make the following changes 
to four process files:

1 Open the Daily_OVO_MSG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3 

c Change block 2 to 

begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_MSG
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_D
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_S
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_A
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_BASE
{DPIPE_HOME}/bin/trendcopy -t SD_OVO_MSG
end: block2 

2 Open the Daily_OVO_ACT_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

c Change block 2 to: 
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begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_ACT
{DPIPE_HOME}/bin/trendcopy -t R_OVO_ACT_BASE
end: block2 

3 Open the Daily_OVO_SRVLOG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

4 Open the Daily_OVO_CONFIG_Rollup.pro file:

• Uncomment block 2

System Clocks

Make sure the system clock on each satellite server is synchronized with the system clock on 
the central server. 
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5 Active Message Reports
The following reports contain information about current unacknowledged messages.

1. OVO Server Summary (see sample page 41)

Provides total number of messages and severity details for each management server; for a 
selected management server, provides statistics for severity, age, and duplicates daily, weekly 
and monthly.

2. Message Severity Trend by All Messages (see sample page 43)

Provides a summary of all messages across all management servers by severity; includes 
statistics for message age, severity, volume, duplicates, and special flag counts hourly, daily, 
weekly and monthly.

3. Message Severity Trend by Application

A list of 15 applications with the most associated messages; includes the following details for 
the selected application: Message age, severity, volume, duplicates, and special flag counts 
hourly, daily, weekly and monthly.

4. Message Severity Trend by Message Group

A list of 15 message groups with the most associated messages; includes the following details 
for a selected message group: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

5. Message Severity Trend by Node and Service

A list of 15 nodes, and corresponding services running on those nodes, with the most 
associated messages; includes the following details for a selected node and service pair: 
Message age, severity, volume, duplicates, and special flag counts hourly, daily, weekly and 
monthly.

6. Message Severity Trend by Server

A list of 15 management servers that have the most associated messages, with the following 
details for a selected Operations management server: message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

7. Message Severity by Server and Application

A list of 15 management servers, and corresponding applications being managed by those 
servers, that have the most associated messages; include the following details for a selected 
management server and application pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.
  41



8. Message Severity by Server and Message

A list of 15 management servers, and corresponding message groups being monitored by those 
servers, that have the most associated messages; includes the following details for a selected 
management server and message group pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

9. Message Severity by Server and Node

A list of the 15 management servers, and corresponding nodes being managed by those 
servers, that have the most associated messages; includes the following details for a selected 
management server and node pair: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

10. Message Severity by Server and Service

A list of 15 management servers, and corresponding services being managed by those servers, 
that have the most associated messages; includes the following details for a selected 
management server and service pair: Message age, severity, volume, duplicates, and special 
flag counts hourly, daily, weekly and monthly.

11. Message Severity by Server, Node and Application 

A list of 15 management servers, and corresponding nodes and applications on those nodes, 
that have the most associated messages; includes the following details for a selected 
management server, node and application: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

12. Message Severity by Server, Node, and Message Group

A list of 15 management servers, and corresponding nodes and message groups from those 
nodes, that have the most associated messages; includes the following details for a selected 
management server, node and message count threesome: Message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

13. Message Severity by Server, Node, and Service

A list of 15 management servers, and corresponding nodes and services on those nodes, that 
have the most associated messages; includes the following details for a selected management 
server, node and service threesome: Message age, severity, volume, duplicates, and special 
flag counts hourly, daily, weekly and monthly.

14. Message Severity by Service

A list of 15 services that have the most associated messages; for a selected service, includes 
statistics for message age, severity, volume, duplicates, and special flag counts hourly, daily, 
weekly and monthly.
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6 History Message Reports
This chapter contains brief descriptions of the reports about history messages. A history 
message can be unacknowledged or acknowledged.

1. History Dashboard by Server and Node

A list of the top 30 management server and nodes with the most severe messages and the 
most special flags.

2. History Dashboard by Server Node and Template 

A list of the top 30 management servers, nodes and templates with the most severe messages 
and the most special flags.

3. Message Age Severity Trend by Server and User

Management servers and users that have the daily messages with the longest age (where age 
refers to the amount of time that it took a user to acknowledge/clear the alarm) and details 
hourly, daily, weekly and monthly message age, severity, volume, duplicates, special flags, and 
delay in seconds for the selected management server and user pair.

4. Message OVO Server Summary

Displays message severity for each Operations management server and for the selected 
server, details message severity, age and duplicates daily, weekly and monthly.

5. Message Severity Trend by All Message 

Provides a summary of all messages across all management servers by severity and details 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

6. Message Severity Trend by Application 

A list of 15 applications that have the most associated messages and details for a selected 
application the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

7. Message Severity Trend by Message Group

A list of 15 message groups that have the most associated messages and details for a selected 
message group the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

8. Message Severity by Node 

A list of 15 nodes that have the most associated messages and details for a selected node the 
message age, severity, volume, duplicates, special flag counts, and delay in seconds hourly, 
daily, weekly and monthly. 
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9. Message Severity by Node and Application 

A list of 15 nodes and corresponding applications on those nodes that have the most 
associated messages and details for a node and application pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

10.Message Severity by Node and Message Group 

A list of 15 nodes and corresponding message groups on those nodes that have the most 
associated messages and details for a node and message group pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

11. Message Severity Trend by Node and Template 

A list of 15 nodes and corresponding templates managing those nodes that have the most 
associated messages and details for a selected node and template pair the message age, 
severity, volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and 
monthly.

12. Message Severity Trend by Node and Service

A list of 15 nodes and corresponding services running on those nodes that have the most 
associated messages and details for a selected node and service pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

13. Message Severity Trend by Server 

A list of 15 Operations management servers that have the most associated messages and 
details for a selected Operations management server the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

14. Message Severity Trend by Server and Message Group 

A list of 15 Operations management servers and corresponding message groups being 
monitored by those servers that have the most associated messages and details for a selected 
management server and message group pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

15. Message Severity by Server and Node 

A list of 15 Operations management servers and corresponding nodes being managed by those 
servers that have the most associated messages and details for a selected management server 
and node pair the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

16. Message Severity by Server and Service

A list of 15 Operations management servers and corresponding services being managed by 
those servers that have the most associated messages and details for a selected management 
server and service pair the message age, severity, volume, duplicates, special flag counts and 
delay in seconds hourly, daily, weekly and monthly.

17. Message Severity by Server 

A list of 15 Operations management servers and corresponding templates monitored by those 
servers that have the most associated messages and details for a selected management server 
and template pair the message age, severity, volume, duplicates, special flag counts and delay 
in seconds hourly, daily, weekly and monthly.
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18. Message Severity by Server and Application 

A list of 15 Operations management servers and corresponding applications being managed 
by those servers that have the most associated messages and details for a selected 
management server and application pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

19. Message Severity by Server, Node and Application 

A list of 15 Operations management servers and corresponding nodes and applications on 
those nodes that have the most associated messages and details for a selected management 
server, node and application threesome the message age, severity, volume, duplicates, special 
flag counts and delay in seconds hourly, daily, weekly and monthly.

20. Message Severity by Server, Node and Message Group 

A list of 15 Operations management servers and corresponding nodes and message groups 
from those nodes that have the most associated messages and details for a selected 
management server, node and message count threesome the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

21. Message Severity by Server, Node and Service 

A list of 15 Operations management servers and corresponding nodes and services on those 
nodes that have the most associated messages and details for a selected management server, 
node and service threesome the message age, severity, volume, duplicates, special flag counts 
and delay in seconds hourly, daily, weekly and monthly.

22. Message Severity by Server, Template and Condition 

A list of 15 Operations management servers and corresponding monitored templates and 
occurred conditions on those servers that have the most associated messages and details for a 
selected management server, template and condition threesome the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

23. Message Severity Trend by Server and User

A list of 15 Operations management servers and corresponding users on those servers that 
have the most associated messages and details for a selected management server and user 
pair the message age, severity, volume, duplicates, special flag counts and delay in seconds 
hourly, daily, weekly and monthly.

24. Message Severity Trend by Service 

A list of 15 services that have the most associated messages and details for a selected service 
the message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

25. Message Severity by Template

A list of 15 templates that have the most associated messages and details for a selected 
template the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.
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26. Message Severity by Template and Condition

A list of 15 templates and corresponding occurred conditions that have the most associated 
messages and details for a selected template and condition pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and 
monthly.

27. Message Severity by User 

A list of 15 users that have the most associated messages and details for a selected user the 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

28. Monthly Server Breakdown with Special Flag 

A list of the top 20 Operations management servers with the most messages with notify and 
trouble ticket details and a graph of hourly, daily, weekly and monthly special flag counts.

29. Template Breakdown with Special Flags 

A list of the top 20 templates with the most messages with notify and trouble ticket details 
and a graph of hourly, daily, weekly, and monthly special flag counts.
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7 Configuration Reports
The OVO Report Pack includes two configuration reports:

1. Notification Channels

Lists the program, service, day, starting time and ending time for each Operations 
management server notification channel for the current and previous day.

2. Trouble Ticket Channels (see sample page 46)

Shows the program, on/off flag and time period for each Operations management server for 
the current and previous day.
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Appendix A: Import and Reporting Tables
This appendix contains the following tables:

• Import tables:

— (1) History message table

— (2) Active message statistics table

— (3) Service log entries table

— (4) Configuration entries table

• Reporting tables:

— (5) History message property table

— (6) History message data tables

— (7) Consolidated message metrics by time interval

— (8) Active message property table

— (9) Active message data tables

— (10) Active message metrics by time interval

— (11) Service log property table

— (12) Service log data tables

— (13) Service log metrics by time interval
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OVO Field

ACKN_AFTER_TT_FLAG

ACKN_TIME

ACKN_USER

APPLICATION

AUTO_ACKN_FLAG

AUTO_ANNO_FLAG

AUTO_CALL

AUTO_NODE_ID

AUTO_STATUS

CMA_FLAG

DESCRIPTION

CONDITION_ID

DUPL_COUNT

ESCALATE_FLAG

FORWARD

IP_ADDRESS

LAST_TIME_RECEIVED
1. History Message Import Table

R_OVO_MSG_BASE

K_OVO_MSG_BASE 

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE

OVO_SERVER Vchar(16)

ACKN_AFTER_TT_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ACKN_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ACKN_USER Vchar(20) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

APPLICATION Vchar(254) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_ACKN_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_ANNO_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_CALL OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

AUTO_STATUS OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

DESCRIPTION Vchar(254) OPC_COND, 
OPC_TRAP_COND, 
OPC_MONITOR_COND

OPC_COND, 
OPC_TRAP_COND, 
OPC_MONITOR_COND

CONDITION_ID Vchar(36) OPC_MSG_MESSAGES OPC_ACT_MESSAGES

DUPL_COUNT OPC_MSG_MESSAGES OPC_ACT_MESSAGES

ESCALATE_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

FORWARD OPC_MSG_MESSAGES OPC_ACT_MESSAGES

IP_ADDRESS OPC_NODE_NAMES OPC_NODE_NAMES

LAST_TIME_RECEIVED OPC_MSG_MESSAGES OPC_ACT_MESSAGES
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LOCAL_RECEIVING_TIME

LOCAL_ACKN_TIME

LOCAL_AGT_CREATION_TI
ME

LOCAL_CREATION_TIME

LOCAL_LAST_TIME_RECEI
VED

LOCAL_RECEIVING_TIME

LOCAL_UNBUFFER_TIME

LOG_ONLY_FLAG

MESSAGE_GROUP

MESSAGE_NUMBER

MESSAGE_TYPE

MSG_GEN_NODE_ID

MSG_KEY

MSG_SOURCE_NAME

MSG_SOURCE_TYPE

NODE_ID

NODE_NAME

NOTIFICATION_FLAG

NOTIFY_SERVICES

OBJECT

OP_INIT_ACKN_FLAG

OP_INIT_ANNO_FLAG

OVO Field
LOCAL_RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_ACKN_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_AGT_CREATION_T
IME

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_CREATION_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_LAST_TIME_RECE
IVED

OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOCAL_UNBUFFER_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

LOG_ONLY_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_GROUP OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_NUMBER OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MESSAGE_TYPE OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_GEN_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_KEY OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_SOURCE_NAME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

MSG_SOURCE_TYPE OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NODE_NAME Vchar(64) OPC_NODE_NAMES OPC_NODE_NAMES

NOTIFICATION_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

NOTIFY_SERVICES OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OBJECT OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_ACKN_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_ANNO_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE
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OP_INIT_CALL

OP_INIT_NODE_ID

OP_INIT_STATUS

RECEIVING_TIME

SERVICE_NAME

SEVERITY

TROUBLE_TICK_FLAG

UNBUFFER_TIME

UNMATCHED_FLAG

cma_name

cma_value

service_id

status_flag

TEMPLATE_ID

TEMPLATE_NAME

TEMPLATE_DESCRIPTION

APPLICATION_ID

OVO Field
OP_INIT_CALL OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_NODE_ID OPC_MSG_MESSAGES OPC_ACT_MESSAGES

OP_INIT_STATUS OPC_MSG_MESSAGES OPC_ACT_MESSAGES

RECEIVING_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

SERVICE_NAME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

SEVERITY OPC_MSG_MESSAGES OPC_ACT_MESSAGES

TROUBLE_TICK_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

UNBUFFER_TIME OPC_MSG_MESSAGES OPC_ACT_MESSAGES

UNMATCHED_FLAG OPC_MSG_MESSAGES OPC_ACT_MESSAGES

cma_name opc_MSG_cust_attrib opc_act_cust_attrib

cma_value opc_MSG_cust_attrib opc_act_cust_attrib

service_id opc_notif_schedule opc_notif_schedule

status_flag opc_trouble_ticket opc_trouble_ticket

TEMPLATE_ID Vchar(36) opc_templ_options opc_templ_options

TEMPLATE_NAME opc_templ_options opc_templ_options

TEMPLATE_DESCRIPTION Vchar(254) opc_templ_options opc_templ_options

APPLICATION_ID Vchar(254) Opc_msg_Messages Opc_act_messages

OVPI Field  Type OVO Table(s) HISTORY OVO Table(s) ACTIVE
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Comment

Created by export process

All records

All records

ONA records only

ONS records only

ONM records only

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records
2. Active Message Import Table

R_OVO_ACT_BASE

K_OVO_ACT_BASE

Column Name Data Type Description  Source Table

OVO_SERVER varchar(128) OV server records were exported 
from

NODE_NAME (based on 
NODE_ID)

varchar(254)
varchar2(1024)

 OPC_NODE_NAMES

NODE_ID (ID of node where 
event occurred)

varchar2(36) OPC_ACT_MESSAGES

APPLICATION varchar2(254) ONA records only OPC_ACT_MESSAGES

SERVICE_NAME varchar2(2048) ONS records only OPC_ACT_MESSAGES

MSG_GROUP varchar2(32) ONM records only OPC_ACT_MESSAGES

OVO_GMT_OFFSET number(12)

CNT_MESSAGES gauge/float Count of current ACTIVE 
messages

OPC_ACT_MESSAGES

CNT_UNKNOWN gauge/float With severity = 1 = unknown OPC_ACT_MESSAGES

CNT_NORMAL gauge/float With severity = 2 = normal OPC_ACT_MESSAGES

CNT_WARNING gauge/float With severity = 4 = warning OPC_ACT_MESSAGES

CNT_CRITICAL gauge/float With severity = 8 = critical OPC_ACT_MESSAGES

CNT_MINOR gauge/float With severity = 16 = minor OPC_ACT_MESSAGES

CNT_MAJOR gauge/float With severity = 32 = major OPC_ACT_MESSAGES

MIN_AGE_MSG gauge/float Minimum age of current 
ACTIVE messages

OPC_ACT_MESSAGES

MAX_AGE_MSG gauge/float Maximum age of current 
ACTIVE messages

OPC_ACT_MESSAGES
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All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

All records

Comment
AVG_AGE_MSG gauge/float Average age of current ACTIVE 
messages

OPC_ACT_MESSAGES

TOT_AGE_MSG gauge/float Total age of current ACTIVE 
messages

OPC_ACT_MESSAGES

CNT_AGE_5_MIN gauge/float Messages less than 5 minutes 
old

OPC_ACT_MESSAGES

CNT_AGE_5_10_MIN gauge/float >= 5 minutes and < 10 minutes OPC_ACT_MESSAGES

CNT_AGE_10_30_MIN gauge/float >= 10 minutes and < 30 minutes OPC_ACT_MESSAGES

CNT_AGE_30_60_MIN gauge/float >= 30 minutes and < 60 minutes OPC_ACT_MESSAGES

CNT_AGE_60_120_MIN gauge/float >= 60 minutes and < 120 
minutes

OPC_ACT_MESSAGES

CNT_AGE_120_720_MIN gauge/float >= 120 minutes and < 720 
minutes

OPC_ACT_MESSAGES

CNT_AGE_720_1440_MIN gauge/float >= 720 minutes and < 1440 
minutes

OPC_ACT_MESSAGES

CNT_AGE_GT_1440_MIN gauge/float > 1440 minutes OPC_ACT_MESSAGES

CNT_CURR_BUFFERED gauge/float Count current buffered 
messages

OPC_ACT_MESSAGES

CNT_PREV_BUFFERED gauge/float Count messages previously 
buffered

OPC_ACT_MESSAGES

CNT_DUPL_COUNT gauge/float Total duplicates received OPC_ACT_MESSAGES

CNT_DUPL_MSG gauge/float Count of messages receiving 
duplicates

OPC_ACT_MESSAGES

CNT_ESCALATE_FLAG gauge/float Count flagged as escalated OPC_ACT_MESSAGES

CNT_AUTO_ACKN_FLAG gauge/float Count flagged as auto 
acknowledge

OPC_ACT_MESSAGES

CNT_LOG_ONLY_FLAG gauge/float Count flagged as log only OPC_ACT_MESSAGES

Column Name Data Type Description  Source Table
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All records

All records

All records

ONA

All records

ONS

Comment
CNT_NOTIFICATION_FLAG gauge/float Count flagged to send 
notification

OPC_ACT_MESSAGES

CNT_TROUBLE_TICK_FLAG gauge/float Count flagged to generate 
trouble ticket

OPC_ACT_MESSAGES

CNT_ACKN_AFTER_TT_FLA
G

gauge/float Count flagged to auto 
acknowledge after generating 
trouble ticket

OPC_ACT_MESSAGES

APPLICATION_ID Number Unique ID for long application 
names

NA

NODE_IP_ADDR Number IP Address in long form OPC_NODES

SERVICE_NAME_ID Number Unique ID for long service 
names

NA

Column Name Data Type Description  Source Table
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Comment

Created by export process

Created by export process

Created by export process

1.  Unknown
2.  Normal
4.  Warning
8.  Critical
16. Minor
32. Major

TA_PERIOD

Created by export process

Created by export process

Created by export process
3. Service Log Import Table

R_OVO_SRVLOG_BASE

K_OVO_SRVLOG_BASE

Column Name Data Type Column Sample Data  OVO Source Table

SPLIT_FLAG number

ORIG_TA_PERIOD date 18/6/2007 10:03:43 PM

OVO_SERVER varchar(128)

SERVICE_NAME varchar2(2048) SeM_SPI:Server@@nsprod01 OPC_SERVICE_LOG

SEVERITY number(3) 4 OPC_SERVICE_LOG

START_TIME number(12) 1108624087 OPC_SERVICE_LOG

LOCAL_START_TIME date 4/5/2005 10:03:43 PM OPC_SERVICE_LOG

END_TIME number(12) 1108624087 OPC_SERVICE_LOG

LOCAL_END_TIME date 4/5/2005 11:03:43 PM OPC_SERVICE_LOG

DURATION number(12) 1108624087

OVO_GMT_OFFSET number(12)

EXPORT_TIME number(12) 1108594373
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 4. Configuration Import Table

R_OVO_SRVLOG_BASE [?]

K_OVO_SRVLOG_BASE [?]

Column Name OVOU Source Table Comment

dsi_key_id_ Standard OVPI numeric element ID

ta_period Standard OVPI time stamp

delta_time Standard OVPI column not used in this case

ta_samples Standard OVPI column. Always 1 in this 
case

OVO_SERVER Created by export process

Type Record type indicator TT or NOTIF

NOTIF_SVC_ID Opc_notif_services Service Identifier

NOTIF_SVC_NAME Opc_notif_services Notif Service Name

FLAG opc_trouble_ticket Active/Inactive

PROGRAM Opc_notif_services

opc_trouble_ticket External program

DAY opc_notif_schedule Day for Notif

STARTING opc_notif_schedule Start time for Notif channel

ENDING opc_notif_schedule End time for Notif channel
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_OVO_MSG.
5. History Message Property Table

All OVO Consolidated Message summarized data tables are associated with the K_OVO_MSG property tableK

Column Name Data Type Population Method

dsi_key_id Maintained by OVPI

dsi_target_name Record type indicator based on trend_sum by variables:
O: OVO_SERVER
ON: OVO_SERVER - NODE_NAME 
OA: OVO_SERVER - APPLICATION
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
OU: OVO_SERVER – ACKN_USER
OT: OVO_SERVER – TEMPLATE
OTD: OVO_SERVER – TEMPLATE - DESCRIPTION
ONA: OVO_SERVER – NODE_NAME - APPLICATION
ONS: OVO_SERVER – NODE_NAME - SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - MSG_GROUP
All Msgs (executive summary across all messages)
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP
U: ACKN_USER
T: TEMPLATE
TD: TEMPALTE – DESCRIPTION
N: NODE
NT: NODE – TEMPLATE
NS: NODE – SERVICE
NA: NODE – APPLICATION
NM: NODE – MSG GROUP
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dsi_table_key Due to custom rollup, all by variables, except for 
GRP_LEVEL and the interval by variable, are concatenated
and inserted into dsi_table_key

dsi_status number(3,0) Specifies the global status attribute for the managed object
The default value is 2.

dsi_status_time date Contains the timestamp of the last status. The default valu
is the current time.

dsi_descr Set to same value as dsi_table_key 

GRP_LEVEL Same as dsi_target_name

OVO_SERVER Varchar(128) trend_sum populates based on by variable “OVO_SERVER”

NODE_NAME Varchar(254)
Varchar2(1024)

trend_sum populates based on by variable “NODE_NAME”

APPLICATION Varchar2(254) trend_sum populates based on by variable “APPLICATION

SERVICE_NAME Varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”

ACKN_USER Varchar2(20) trend_sum populates based on by variable “ACKN_USER”

MESSAGE_GROUP VARCHAR(255) trend_sum populates based on by variable “MSG_GROUP”

MSG_SOURCE_NAME VARCHAR(255) trend_sum populates based on by variable “TEMPLATE”

APPLICATION_ID number Unique hash for application

COND_DESCRIPTION_ID number Unique hash for condition description

SERVICE_NAME_ID number

CONDITION_DESCR VARCHAR(255) trend_sum populates based on by variable “CONDITION”

OTHER standard columns 
found in OVPI RPs

Column Name Data Type Population Method
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6. History Message Data Table

7. Consolidated Message Metrics by Time Period

Destination Table Rollup Processing Populating Table

SH_OVO_MSG Populated by several roll-up combinations: SH_OVO_MSG.nnn

SD_OVO_MSG Populated by trend_sum using SD_OVO_MSG.sum

SW_OVO_MSG Populated by trend_sum using SW_OVO_MSG.sum

SM_OVO_MSG Populated by trend_sum using SM_OVO_MSG.sum

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_RECEIVE_DELAY X X X X

MAX_RECEIVE_DELAY X X X X

AVG_RECEIVE_DELAY X X X X

TOT_RECEIVE_DELAY X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X
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AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X

CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X

Metric Hour Day Week Month
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8. Active Message Property Table

All OVOu Active Message summarized data tables are associated with the K_OVO_ACT property table.

K_OVO_ACT

Column Name Data Type Population Method

dsi_key_id Maintained by OVPI

dsi_target_name ON: OVO_SERVER - NODE_NAME 
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
ONA: OVO_SERVER – NODE_NAME - APPLICATION
ONS: OVO_SERVER – NODE_NAME - SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - MSG_GROUP
All Msgs executive summary across all messages
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP

node_id varchar2(128) Unique ID of node where event occurred.

dsi_status number(3,0) Specifies the global status attribute for the managed object. 
The default value is 2.

dsi_status_time date Contains the timestamp of the last status. The default value 
is the current time.

dsi_table_key Due to custom rollup, all by variables, except for 
GRP_LEVEL and the interval by variable, will be 
concatenated and inserted into dsi_table_key

dsi_descr NULL. Not used

GRP_LEVEL Same as dsi_target_name

OVO_SERVER varchar(128) trend_sum populates based on by variable “OVO_SERVER”

NODE_NAME varchar(254) 
archar2(2048)

trend_sum populates based on by variable “NODE_NAME” 
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9. Active Message Data Table

10. Active Message Metrics By Time Interval

APPLICATION varchar2(254) trend_sum populates based on by variable “APPLICATION”

SERVICE_NAME varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”

MSG_GROUP varchar2(32) trend_sum populates based on by variable “MSG_GROUP”

APPLICATION_ID Number Unique hash for the application

SERVICE_NAME_ID Number Unique hash for the service

OTHER standard 
columns found in OVPI 
RPs

Destination Table Rollup Processing Populating Table

SH_OVO_ACT Populated by several roll-up combinations: SH_OVO_ACT.nnn

SD_OVO_ACT Populated by trend_sum using SD_OVO_ACT.sum

SW_OVO_ACT Populated by trend_sum using SW_OVO_ACT.sum

SM_OVO_ACT Populated by trend_sum using SM_OVO_ACT.sum

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

Column Name Data Type Population Method
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CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X

AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X

CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_CURR_BUFFERED X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

Metric Hour Day Week Month
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CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X

Metric Hour Day Week Month
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11. Service Log Property Table

All OVOu Service Log summarized data tables are associated with the K_OVO_SRVLOG property table.

K_OVO_SRVLOG

12. Service Log Data Tables

The following OVOu Service Log rollup tables are used for reporting:

Column Name Population Method

dsi_key_id Maintained by OVPI

dsi_target_name trend_sum populates based on by variable “OVO_SERVER”

dsi_table_key trend_sum populates based on by variable “SERVICE_NAME”

dsi_descr NULL. Not used

OVO_SERVER trend_sum populates based on by variable “OVO_SERVER”

SERVICE_NAME trend_sum populates based on by variable “SERVICE_NAME”

Destination Table Rollup Processing Populating Table

SD_OVO_SRVLOG populated by trend_sum using SD_OVO_SRVLOG.sum

SW_OVO_SRVLOG populated by trend_sum using SW_OVO_SRVLOG.sum

SM_OVO_SRVLOG populated by trend_sum using SM_OVO_SRVLOG.sum
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 13. Service Log Metrics by Time Interval

Metric Day Week Month

CNT_MESSAGES X X X

DURATION_TOTAL X X X

DURATION_UNKNOWN X X X

DURATION_NORMAL X X X

DURATION_WARNING X X X

DURATION_CRITICAL X X X

DURATION_MINOR X X X

DURATION_MAJOR X X X
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